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INTRODUCTION
The Adobe Camera Raw interface is quite deceptive.  Hidden within in are several 
important tools that are easy to miss.  Tag your time and work your way through 
this guide completely to discover new imaging super powers.

A N  E X P E R T  G U I D E  T O  
A D O B E  C A M E R A  R A W



I continued to be amazed at how many people still 
don’t shoot using a raw file format. Sure, I understand 
that certain types of shooters insist they need the faster 
buffer speeds they get when shooting JPEG (though the 
speeds of most modern cameras make this argument 
irrelevant for all but a few shooters).

WHAT IS A RAW FILE?
A raw file contains virtually everything that your 
cameras sensor can see. The data is minimally 
processed (it may have a white balance preset or 
picture style flagged, but not applied). While your 
camera may contain settings for sharpness, exposure, or 
lighting conditions, the raw file stores that info as 
modifiable information and captures the original 

(unmodified) data that came 
through your cameras sensors. 
This is very useful because it 
lets you easily adjust white 
balance, sharpening, and more 
in Lightroom.

Each manufacturer treats the format differently, using a 
proprietary format. Fortunately Adobe frequently 
updates their raw technology to support the newest 
cameras on the market.

To find out if you can access a particular camera format 
from within Adobe software by visiting Adobes web site 
at http://helpx.adobe.com/photoshop/camera-
raw.html.
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INTRODUCTION
What’s so special about raw files? They’re totally the 
secret to getting the best results from every camera. 
Don;t you want every shadow, highlight, and detail 
your camera sees? Of course you do!A
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THE NEED TO PROCESS
A raw file is not ready for printing or sharing out of the 
camera, you’ll need to process it with software such as 
Adobe Camera Raw or Lightroom. This is a good thing 
as it allows you to precisely decide on issues like 
exposure, toning, sharpening, and white balance.
When you develop images in Lightroom, you are 
working at a bit depth of 16 bits per channel. 

This is an  extremely accurate way to represent color. 
Raw files can be much larger than JPEG files. This extra 
data is used to hold more image detail, which can 
reduce, or even eliminate, compression artifacts found 
in JPEG files. However, that extra data can increase the 
time it takes for the files to write to the memory card.
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The original on the right and the Raw file developed on the left. The Upright adjustment was also applied as well as lens correction to remove distortion.



WHAT ABOUT DNG?
In 2004 Adobe released the Digital Negative 
Specification (DNG) file format. The code and 
specifications were made publicly available so 
manufacturers could build in support for the format to 
their products. The goal was to replace several 
proprietary raw file formats with a universal format. 
Despite initial optimism, camera manufacturers have 
been slow to adopt it (some even refusing). At this 
point, DNG files are a useful way to archive raw files and 
attach additional metadata.

You can find out more about DNG at http://
helpx.adobe.com/photoshop/digital-negative.html.

WHY SHOOT RAW?
Most digital cameras (particularly ones aimed at pros 
and enthusiasts), offer a much better series of formats, 
collectively called raw. These raw (or native) formats 
have several benefits over shooting to JPEG. The images 
are usually captured at a higher bit rate, which means 
that the pixels contain more information about the color 
values in the image. Most raw files have a depth of 10, 
12, or even 16 bits per channel instead of the 8 used by 
JPEG. The raw format also has a greater tonal range. 
Raw files can show more details in the shadows and 

iv

The use of raw allows for better preservation of subtle color details 
and a wider range of exposure information.

http://helpx.adobe.com/photoshop/digital-negative.html
http://helpx.adobe.com/photoshop/digital-negative.html
http://helpx.adobe.com/photoshop/digital-negative.html
http://helpx.adobe.com/photoshop/digital-negative.html


highlights. The files are easier to work with as they offer 
greater flexibility and control in image adjustments and 
color correction. The images also have more color 
information.

Most digital cameras (particularly ones aimed at pros 
and enthusiasts), offer a much better series of formats, 
collectively called raw. These raw (or native) formats 
have several benefits over shooting to JPEG. The images 
are usually captured at a higher bit rate, which means 
that the pixels contain more information about the color 
values in the image. Most raw files have a depth of 10, 
12, or even 16 bits per channel instead of the 8 used by 
JPEG. The raw format also has a greater tonal range. 
Raw files can show more details in the shadows and 
highlights. The files are easier to work with in Lightroom 
as they offer greater flexibility and control in image 
adjustments and color correction. The images also have 
more color information.

THE BOTTOM LINE
In this day and age… shoot raw. Storage is cheap. 
Memory cards are cheap. Missing the shot or losing out 
on details that your camera tosses away with the JPEG 
are just not worth saving the extra time and money for 
99% of all shooters. Your mileage may vary, but if you 
haven’t given shooting raw a try lately, be sure to do so.
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THIS BOOK IS SPONSORED BY  
SKYLUM SOFTWARE

CHECK OUT 
LUMINAR FLEX

THE ULTIMATE PHOTOSHOP PLUGIN



ADOBE 
CAMERA 
RAW
The Camera Raw support in Photoshop is 
enabled by a plug-in (essentially an application 
that runs inside Photoshop). With Camera Raw 
you can import and develop raw files, and 
then pass them onto Adobe Photoshop. 
Camera Raw is designed to work with the 
native files recorded by many cameras.
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What’s the Raw Extension?
Raw files are not really a file type but 
rather a description for several 
manufacturer-specific file formats. 
You’ll find several different file formats 
in use, and they will vary by camera 
manufacturer. 

© Simon Zhu



WHAT IS 
RAW?
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A raw file is the secret ingredient to a better image.  It 
contains all the data that your camera’s sensor could 
see.  For this reason it is a superior start to your digital 
imaging pipeline.

A Camera Raw file contains unproc-
essed and uncompressed data, as cap-
tured by the digital camera’s image sen-
sor. These native files contain much 
more color and exposure information 
than a JPEG or TIFF file. The camera 
also includes metadata, such as white 
balance, exposure, and more, specify-
ing how that information should be 
treated.

© dusanpetkovic1

Can I Use Camera Raw?
Not all cameras work with Photoshop 
Camera Raw (although the list is very 
long). Adobe keeps updating the plug-in 
to support new cameras all the time. To 
keep track of Camera Raw and for a list 
of supported cameras, visit 
www.adobe.com/go/learn_ps_cameraraw. 

http://www.adobe.com/go/learn_ps_cameraraw
http://www.adobe.com/go/learn_ps_cameraraw
http://www.adobe.com/go/learn_ps_cameraraw
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OPENING A RAW FILE
To process a raw file, you’ll need to open it with 
Photoshop Camera Raw. Essentially, you need to 
develop the file, deciding during the editing stages 
which information to include. The Camera Raw software 
interprets the metadata and raw file information to 
generate a new image.
The good news is that adjustments you make to a raw 
file are all stored as metadata. The adjustments 
essentially reprocess the raw file data. The Camera Raw 
plug-in writes to a sidecar file, which contains  youi 
instructions on how to treat the raw data. In fact, you 
can have multiple settings for each raw image.

Let’s try opening a file:
1. From Photoshop choose File > Open.. 
2. Navigate to a raw file. 

.You can choose more than one file at a time in 
order to process with the Camera Raw dialog box. 
Just hold down the Command (Ctrl) key and select 
multiple files.

3. Click the Open button to open the selected images 
into the Camera Raw window. 

4. Now that you have something to look at, let’s take a 
quick look at the dialog box and its controls.

9
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AN OVERVIEW 
OF THE 
CAMERA RAW 
DIALOG BOX 
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At first glance, the Camera Raw dialog 
box can be a little overwhelming. It’s 
okay to feel this way, because there 
truly are a lot of sliders and tabs. What 
you’ll find, however, is that the con-
trols are fairly intuitive and very power-
ful. Here’s a quick overview of what 
you’ll find:

Clipped Warnings
As you make adjustments to the raw image, it’s 
possible to clip data (essentially a loss of detail). 
In the Histogram display, you’ll see two small 
triangles. You can click the one on the left for 
shadows and the one on the right for highlights. 
When enabled, clipped shadows appear in blue, 
and clipped highlights appear in red. Highlight 
clipping will warn you if any one of the three RGB 
channels is clipped (fully saturated with no detail). 
Shadow clipping will warn you if all three RGB 
channels are clipped (black with no detail). 

© Miha Jan Strehovec 
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A. Filmstrip. If you select more than a single image to 
open, the images will display here. It is possible to 
apply star rankings to images in the Filmstrip. You 
can also synchronize the settings between multiple 
clips. Just adjust one image, select similar images, 
and then click the Synchronize button.

B. Toggle Filmstrip. If you don’t want to see the 
Filmstrip, just double-click the bar. You can also drag 
to resize the preview thumbnails.

C. Camera name or file format. The camera name 
and model appears at the top of the window so you 
know more about the file.

D. Toggle full-screen mode. It is possible to maximize 
the Camera Raw window to see more details and a 
larger interface. Click to toggle between the larger 
and default view.

E. Image adjustment tabs. There are ten tabs in total 
for controlling the development of Camera Raw files. 
More on these in the next section.

F. Histogram. The Histogram displays the tonal range 
of the developing image. The left edge shows the 
shadows, whereas the right shows the highlights. 
The histogram is interactive in that you can click and 
drag its sections to adjust the exposure of the image.

G. Camera Raw Settings menu. Click this submenu to 
access controls for saving and loading custom 
settings as well as resetting the default settings..

H. Zoom levels. You can adjust the magnification level 
of the image. The most accurate view is 100%, but 
you’ll likely choose to zoom out to see the entire 
image in full.

I. Workflow options. You can specify how images 
will be saved from Camera Raw and how they will 
be opened in Photoshop. Clicking the blue 
hyperlinked text lets you choose a color mode, bit 
depth, file size, and resolution.

J. Navigation arrows. Let you switch between 
multiple images. These work well if the Filmstrip is 
hidden.

K. Comparison views. Compare the original image to 
the edited image with multiple view options.

L. Adjustment sliders. For each adjustment tab, you’ll 
find a set of sliders. These controls are essential for 
developing the image.
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Go Big 
One of the major benefits of shoot-ing raw is an 
increased bit depth. Be sure to click the Workflow 
Options link and set Camera Raw to develop 16-bit 
files. In the Work-flow Options dialog box, you can 
also choose Open in Photoshop as Smart Objects. 



THE RAW TOOLBAR
Across the Camera Raw window is its own toolbar. 
You’ll see several similarities to the Photoshop tools 
you’re already familiar with:

A. Zoom tool (Z). You can click on an image to zoom 
into an area. You can also click and drag to make a 
selection for zooming.

B. Hand tool (H). When zoomed, you can use the 
Hand tool to pan across an image. Hold down the 
spacebar to temporarily switch to the Hand tool.

C. White Balance tool (I). You can override the white 
balance settings written by the camera. Just click to 
select the tool, and then click on an area of the im-
age that should be white, gray, or black.

D. Color Sampler tool (S). You can add up to eight 
sample points. These are useful ways to track 
changes in color as you make adjustments to an im-
age. Many users will place a sampler on a white and 
black area of an image to track any shifts in color.

E. Targeted Adjustment tool (T). There are five differ-
ent tools to choose from. Click and hold to select 
specific tools.

F. Crop tool (C). You can crop freely or select from 
several preset aspect ratios. Remember that any ad-
justments you make are nondestructive. The crop-
ping will be applied when the image is opened.

G. Straighten tool (A). If your photo is crooked, just 
select the Straighten tool. Click and drag with the 
Straighten tool in the preview image to establish a 
horizontal or vertical angle.

H. Transform tool (Shift+T). Easily fix perspective is-
sues with the powerful Upright adjustment com-
mands.  Or manually tilt or rotate your image to ad-
dress unwanted visual issues.

I. Spot Removal tool (B). The Spot Removal tool lets 
you heal or clone imperfections in the raw file. The 
most typical problem you’ll need to tackle is sensor 
or lens dust.

J. Red Eye Removal tool (E). If an image has red eye, 
select this tool and click on the center of the pupil.

K. Adjustments Brush (K). This powerful tool lets you 
brush in localized color and exposure adjustments. 
Click and brush over an area to define it, and then 
adjust settings with the Adjustment sliders.
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L. Graduated Filter (G). This tool is similar to the 
Adjustments Brush except it allows you to create a 
transitioned adjustment gradually between two 
points. This is most typically used to fix areas like a 
sky.

M. Radial Filter (J). This tool is similar to Graduated 
filter except it draws its shape as an ellipse or circle.  
Be sure to choose whether the adjustment applies 
inside or outside the shape.

N. Open Preferences dialog box (Command+K or 
Ctrl+K) There are several important choices here 
including auto-toning, the handling of non-raw files, 
and GPU acceleration

O. Rotate Image Left (L). Rotates the image 90˚ 
counterclockwise.

P. Rotate Image Right (R). Rotates the image 90˚ 
clockwise.

Q. Toggle Mark for Delete. Allows you to flag an 
image for deletion.
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Targeted Adjustment Tool 
This tool is an absolute dream to use and it 
will significantly speed up your editing 
workflow.  You can just click and drag right 
on the image to make a quick change.

‣ Parametric Curve: Adjust the tone of your 
image by simply dragging up to lighten or 
down to darken the targeted area.

‣ Hue: Drag left or right to shift the hue of the 
targeted area.  

‣ Saturation: Drag up to increase or down to 
decrease the saturation for the targeted 
area. 

‣ Luminance: Drag up to lighten or down to 
darken the the targeted area. 

‣ Black & White Mix:  This tool only works if 
you choose the Black and White treatment 
option in the Basic tab.  It is used to create a 
custom black and white conversion.



KEYBOARD 
SHORTCUTS
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Result Windows macOS

White balance I I

Zoom Z Z

Hand H H

Crop C C

Straighten/Align A A

Sampler S S

Targeted Adjustment T T

Spot/Retouch B B



Result Windows macOS

Red Eye E E

Delete object or mask Backspace Delete

Adjustment Brush K K

Gradient G G

Reverse gradient X X

Radial Filter J J

Transform Tool Shift + T Shift + T

Toggle Transform loupe Shift + L Shift + L

Radial Filter brush Shift + K Shift + K

Commit current mask and create a 
new mask

N N

Create new preset Control + Shift + P Command + Shift + P

Create new snapshot Control + Shift + S Command + Shift + S



MASTERING 
IMAGE 
ADJUSTMENTS

The Camera Raw dialog box offers ten tabs to 
process your raw files. The tabs are organized 
by task. Normally, you’ll use only some of the 
tabs to adjust each image. For learning pur-
poses, let’s take a look at each.
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‣ Basic 
Adjust white balance, color saturation, and tonality.

‣ Tone Curve 
Fine-tune tonality using a Parametric curve and a 
Point curve.

‣ Detail: 
Sharpen images and reduce noise.

‣ HSL / Grayscale  
Fine-tune colors using Hue, Saturation, and 
Luminance adjustments.

‣ Split Toning  
Color monochrome images or create special effects 
with color images.

‣ Lens Corrections  
Compensate for chromatic aberration, geometric 
distortions, and vignetting caused by the camera 
lens.

‣ Effects  
Simulate film grain or apply a post-crop vignette.

‣ Camera Calibration  
Apply camera profiles to raw images to correct color 
casts and adjust non-neutral colors to compensate 
for the behavior of a camera’s image sensor.

‣ Presets  
Save and apply sets of image adjustments as presets.

‣ Snapshots  
Create versions of a photo that record its state at any 
point during the editing process.
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CAMERA RAW IMAGE ADJUSTMENT TABS



BASIC 

19

SE
C

T
IO

N
 1

The Basic tab lets you make primary 
adjustments to white balance, color 
saturation, and tonality. These are the 
most important controls and the ones 
you’re most likely to change.

It is here that you can take control over 
key elements like exposure and color.  
These adjustments will apply to the 
image as a whole.  Don’t worry if you 
can’t achieve all the results here, the 
use of the HSL tab and the Graduated 
and Radial filters can also help refine 
your image.



RAW PROFILES
Near the top of the Basic tab is a button 
to open the Profiles Browser. This is 
makes it easy to access DNG Camera 
Profiles (DCPs). These can simulate the 
traditional in-camera recipes used to 
process JPEG files by each camera 
manufacturer.  They can also unlock 
creative profiles for new looks.

1. Click the four square icon to open up the Profile 
Browser.

2. Choose a DNG Camera Profile
• Adobe Raw
• Camera Matching
• Creative

3. Adjust the Amount slider if using a Creative profile.
4. Click Close to return to the Basic tab for further 

edits. 

20



WHITE BALANCE
There are three major controls for affecting the white 
balance of your image..  When set properly, the white 
balance ensures that your image shows no color casts.

‣ White Balance: This pop-up lists offers several 
presets that are similar to those offered by your 
camera.  Each is well-suited for different lighting 
conditions. 
• Presets include Daylight, Cloudy, Shade, 

Tungsten, Fluorescent, and Flash.
• Choose As Shot to restore what your camera 

captured.  
• Use Auto to analyze the image and calculate a 

new value.

‣ Temperature: This adjustment effectively warms or 
cools the shot to compensate for the color 
temperature. 
• Decrease Temperature to correct a photo taken 

with a lower color temperature of light/
• Increase Temperature to correct a photo taken 

with a higher color temperature of light; the image 
colors become warmer (yellowish) to 
compensate.

‣ Tint: This control compensates for green color casts 
for photos made under fluorescent light.

TONE CONTROLS
The next controls are useful for refining the exposure or 
tone of an image. You can click Auto to have Camera 
Raw analyze the image and make adjustments. Click 
Default to restore the default settings (zero values).

‣ Exposure: Adjusts the overall image brightness. 
Exposure values are in increments equivalent to 
aperture values (f‐stops) on a camera. 
‣ Contrast: This adjustment mainly affects the 

midtones. When you increase contrast, the middle-
to-dark image areas become darker, and the middle-
to-light image areas become lighter. 
‣ Highlights: This affects the brighter areas of a photo.  

Drag to the left to darken highlights and recover 
“blown out” details. Drag to the right to brighten the 
highlights while minimizing image clipping.
‣ Shadows: This affects the darker areas of a photo 

Drag to the left to darken shadows while minimizing 
clipping. Drag to the right to brighten shadows and 
recover lost details.
‣ Whites: This affects the white point of an image and 

where it clips. Drag to the right to increase highlight 
clipping. or to the left to decrease.
‣ Blacks: This affects the black point of an image.  

Drag to the left to increase black clipping (to push 
more shadows to a pure black). Drag to the right to 
reduce shadow clipping. 21



DEPTH & COLOR 
CONTROLS
The next four controls allow you to enhance the 
amount of color in an image as well as to selectively 
enhance contrast in areas that lack it most.  These 
sliders are quite useful, but should be used cautiously 
to avoid an over-processed image.

‣ Texture: Adds or subtracts fine detail.

‣ Clarity: Adds depth to an image by increasing 
local contrast.  It has the most impact on the 
midtones of an image.  Be sure to zoom to 100% 
to best view the effect.  Be careful as higher values 
can introduce a halo along the edges.

• Double-click the Zoom tool to switch to 100% 
magnification.

‣ Dehaze: This useful adjustment can help restore 
light that was lost due to atmospheric haze.   Be 
sure to properly set the White Balance for the 
image before using this control.

‣ Vibrance: This adjustment targets areas that have 
a lower saturation.  It is useful to  enhance 
saturation without color clipping. Vibrance also 
prevents skin tones from becoming oversaturated.

‣ Saturation:  This affects the overall saturation of 
image colors equally.  It ranges from -100 
(monochrome) to +100 (double the saturation). 22

ORIGINAL IMAGE

ENHANCED WITH 
BASIC CONTROLS



TONE 
CURVE
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With the Tone Curve tab, you can 
fine-tune tonality in an image with 
controls similar to Photoshop’s Curves 
adjustment. You can choose to use 
either a Parametric curve or a Point 
curve.

Each curve offers a different way to 
enhance contrast and definition.  They 
can be used individually or combined 
based on your preference.



PARAMETRIC CURVE
When you view the graph in the Tone Curve panel, you 
can see the tonal scale of a photo.  The horizontal axis 
represents the original tone values or input values.  The  
blacks are on the left with progressively lighter values to-
ward the right.

With the Parametric Curve, you can drag any of the 
four Region sliders left or right to affect those areas in 
the image. As you drag, the curve moves within the af-
fected region.  

‣ Highlights

‣ Lights

‣ Darks

‣ Shadows

If you want to redefine these regions, just drag the split 
controls at the bottom of the tone curve graph.

24



POINT CURVE
The Point Curve can be used to target the overall im-
age or to adjust a color channel independently.  This is a 
useful way to remove stubborn color casts or to boost a 
color for stylistic reasons.

‣ Click on the curve and or down. As you drag, the 
Curve changes and you’ll see the numbers update in 
the Input and Output fields.

‣ Choose an option from the Curve menu to apply a 
default Curve to enhance contrast.
• Linear
• Medium Contrast
• Strong Contrast

‣ Drag an exiting point on the Curve to affect contrast.  
Drag up to lighten an area and drag down to darken.

‣ Click on the Curve to add a control point.

‣ Ctrl-click (Windows) or Command-click (macOS) 
within the image to add a control point that matches 
the tonal range for where you clicked.

25
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DETAIL
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The Detail tab offers precise control 
over both sharpening an image as well 
as reducing noise. All raw images will 
need some sharpening. Noise, on the 
other hand, may not appear unless the 
image was shot with a high ISO setting 
especially under low light.

To best see detail, double-click the 
Zoom tool to switch to 100% 
magnification. Now it’s easier to 
accurately judge both sharpening and 
noise reduction at a 100% 
magnification.  .



SHARPENING
In the Detail tab, you can adjust sharpening to bring 
out fine image details:

‣ Amount. Increases definition at the edges of an im-
age. Use a lower amount for a cleaner image. When 
you open the file, the Camera Raw plug-in calculates 
the settings to use based on camera model, ISO, and 
exposure compensation. 

‣ Radius. Use a low number for fine detail and a 
higher number if the photo lacks much detail.  

‣ Detail. Controls how much high-frequency informa-
tion is sharpened in the image and how the edges 
are emphasized.

‣ Masking. Controls the edge of the mask. Using a 
value of zero means that everything receives the 
same amount of sharpening. A higher number limits 
the sharpening to those areas near the strongest 
edges.

An easy way to tell how much masking to use is to hold 
down the Option (Alt) key while dragging the Masking 
slider. White areas will be sharpened; black areas are 
ignored (masked)..

28



NOISE REDUCTION

Noise reduction controls let you remove extra grain 
from the image:

‣ Luminance. Reduces luminance noise. 

‣ Luminance Detail. Sets a threshold for the noise 
reduction. Higher values preserve detail but can 
produce noisier results. Lower values tend to 
produce cleaner results but likely remove some 
detail.

‣ Luminance Contrast. Works best for very noisy 
photos. 

‣ Color. Reduces color noise. 

‣ Color Detail. Use a higher value to protect detailed 
edges. A lower value preserves more color but can 
result in color bleeding. 

‣ Color Smoothness.  This is a useful control to 
remove areas that appear splotchy.

29
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HSL/
GRAYSCALE
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The visible controls here are affected 
by the Basic tab.  If you leave Color 
selected, you’ll see HSL controls.  If 
you chose a Black & White image, 
you’ll see a Grayscale sliders for each 
tone in the Black & White image..

The HSL/Grayscale tab offers fine-
tuning controls for Hue, Saturation, and 
Luminance adjustments. The most 
typical use of this tab is to target a 
particular color or tone that needs 
emphasis.

Targeted Adjustment Tool 
Remember to use the Targeted Adjustment  
Tool for easy manipulation of the HSL 
controls.



CONTROLS
The controls for all three tabs are essentially the same.  
Eight sliders are offered for the different color ranges.  

‣ Hue. This targets a particular color in the spectrum.  
Dragging the slider shifts the hue towards a new 
color.  You can anticipate the affect by looking at the 
color spectrum for each slider.

‣ Saturation. This is the intensity of the color. Dragging 
to the right increases saturation.  Dragging to the left 
reduces the intensity of the color. 

‣ Luminance. Controls how light or dark a particular 
color is.. Drag to the right to lighten and to the left to 
darken. You can anticipate the affect by looking at 
the spectrum below each slider.

32
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SPLIT 
TONING
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This panel is a useful way to 
emphasize a specific color for both the 
Highlights and Shadows areas.  The 
controls can be used to create both 
subtle and dramatic effects.

There are really two ways to use the 
Split Toning panel.  With a grayscale 
image, it can bring out traditional 
cross-processing techniques (such as a 
sepia tone or cyanotype).  When used 
with a full-color image, the effect is 
useful for creating a vintage feeling or 
for emphasizing warn and cool tones.



CONTROLS
‣ Highlights. Targets the brighter areas of the image.  

• You can choose the color to emphasize with the 
Hue slider. 

• Then use the Saturation slider to adjust its inten-
sity.

‣ Balance. This refines the balance between Shadows 
and Highlights.  Drag the slider to favor one area 
more over another.

‣ Shadows. Works the same as the Highlights con-
trols, except for the darker areas of the image.

SHORTCUT KEYS
Hold  down the Option (macOS) / Alt (Win) key when 
dragging to help select the right values for split toning.

‣ Option (macOS) / Alt (Win) drag the Hue slider 
to temporarily view the colors at 100% saturation.  
This makes it easier to choose the desired color/hue. 
Then release the keyboard modifier and use the Satu-
ration slider to dial in the desired amount of color.

‣ Option (Mac) / Alt (Win) drag the Balance slider 
to temporarily preview the Split Tone saturation at 
100% – making it easier to see where the colors split 
in the image.
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The Lens Corrections tab attempts to 
compensate for defects in lens 
technology. The most common 
problems include distortion, chromatic 
aberration and vignetting. Adobe offers 
an extensive database  of lens profiles 
that can fix a variety of problems 
automatically.  Additionally, manual 
controls can be used for further 
refinement or for un-profiled lenses.

Create Your Own Profiles
Print out the calibration targets and 
capture a series of images with your 
camera.  This  software then builds a 
unique profile to remove vignettes, 
distortion, and aberration.
https://helpx.adobe.com/photoshop/
digital-negative.html

figure:%23
figure:%23
figure:%23
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PROFILE
‣ Remove Chromatic Aberration: This checkbox 

automatically corrects blue-yellow and red-green 
fringes Chromatic aberration often occurs in images 
made with large apertures (especially in high-
contrast areas). It's a good practice to always check 
the Remove Chromatic Aberration box.

‣ Enable Profile Corrections: Checking this box will 
enable automatic correction.  Adobe Camera Raw 
will analyze the metadata of the file and attempt to 
correct distortions in common camera lenses. The 
profiles are based on EXIF metadata that identifies 
the camera and lens used.  If no profile is automati-
cally found, you can attempt to choose a compatible 
option.

1. If Camera Raw doesn’t find a suitable profile 
automatically, choose the Make, Model, and Profile.

2. Use the Distortion slider to apply the adjustment. 
The default value 100 applies 100% of the distortion 
correction in the profile. Values over 100 apply 
greater correction to the distortion; values under 
100 apply less correction to the distortion.

3. Use the Vignetting slider to remove dark edges. 
The default value 100 applies 100% of the 
vignetting correction in the profile. Values over 100 
apply greater correction to vignetting; values under 
100 apply less correction to vignetting.
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MANUAL
If you want to refine the lens correction even more (or if no 
profile is available) try out the manual controls.

‣ Distortion: Drag to the right to correct barrel distortion.  
This will straighten lines that bend away from the center. 
Drag to the left to fix pincushion distortion.  This 
straightens lines that bend toward the center. 

‣ Defringe: These controls can tackle any  global purple or 
green fringes .

• Purple Amount/Green Amount 
Specifies the amount of defringing applied to the 
selected Purple Hue/Green Hue. The higher the 
amount, the more defringing is applied. 

• Purple Hue/Green Hue 
Applies defringing to the selected Hue range. Drag 
either end-point control to expand or decrease the 
affected range of colors. Drag between the end point 
controls to slide the hue range. 

‣ Vignetting: This corrects an unwanted exposure change 
at the edge of the image. 

• Amount 
Move the Amount slider to the right to lighten the cor-
ners of the image. Move the slider to the left to darken 
the corners of the photo.

• Midpoint 
Drag the Midpoint slider to the left  to apply the Vi-
gnette correction to a larger area away from the cor-
ners. Drag the slider to the right to restrict the adjust-
ment to a smaller area near the corners. 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Sample the Fringe
To correct fringing with the Eyedropper 
tool, do the following:
1. Zoom into the fringe area to facilitate 

accurate color picking.
2. Press and hold Command (Mac) or 

Control (Win) to show the Eyedrop-
per tool on the image.

3. Click purple/green fringe colors to 
select them more accurately.

See the Fringe Clearly
Be sure to zoom into an area that has 
very dark or black detail against a very 
light or white background.  This is where 
you’ll likely see color fringing.

To more clearly see the color fringing, 
press Alt (Windows) or Option (macOS) 
as you move a slider to hide any color 
fringe corrected by other color sliders. 



EFFECTS
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The Effects tab can be used to stylize 
the image. It is used to add 
photographic imperfections that were 
more typical with film-based cameras. 
You can choose to simulate film grain 
or apply a post crop vignette to the 
edges. 



GRAIN
While many photographers strive for noise free images, the 
lack of grain in a digital image often looks artificial to 
photography purists.  Adding a small amount of grain can 
restore the traditional filmic qualities to a photograph. For 
best results zoom to a 100% view.

‣ Amount: How much grain is added to the image.

‣ Size: The relative size of the grain.

‣ Roughness: How much contrast the grain pattern adds.

POST CROP VIGNETTING
While the Lens correction can remove a vignette, some us-
ers like the effect.  But if the image has been cropped the vi-
gnette may no longer be applied equally to all corners. This 
is where the Post Crop vignetting controls come in handy.

‣ Style: You’ll find three different options for how the 
vignette shades the image. 

‣ Amount: Use a negative value to darken the edges or a 
positive to brighten them. 

‣ Midpoint: Controls how close the vignette appears to 
the corner of the image.

‣ Roundness:. A positive value creates a circular effect, 
whereas a negative value takes on an oval shape. 

‣ Feather: Can create a gentler transition between the 
affected areas. 

‣ Highlights: If you’re using a very dark vignette, the 
Highlights slider can be used to protect the brightest 
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Feather Off... Feather On
: Move the Feather slider all the way to 
the left to see the area affected by the 
vignette. Adjust the Midpoint and 
Roundness to shape the vignette. Finally  
adjust the Feather control. 



CAMERA
CALIBRATION
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The Calibration tab is used to choose 
which technology is accessed under 
the hood to render raw files.  Adobe 
has continued to improve their raw 
engine, yet makes older ones 
accessible for backwards compatibility 
and user preference.

Depending on which process version 
you use, different options and settings 
are available in the Adobe Camera 
Raw dialog.  In most cases, stick with 
the most current process.



PROCESS VERSIONS
‣ Process Version 5 

Any image that is first edited in Camera Raw 11 uses 
Process Version 5. This version features improved high 
ISO rendering that helps remove purple color casts.  
These can be visible in the shadows of lower light 
images. PV5 also features an improved Dehaze slider. 
You can easily add haze for creative reasons when you 
move the Dehaze slider to the left.

‣ Process Version 4 
If an image is edited for the first time in Camera Raw 10 it 
uses process version 4. This version adds support for the 
Range Mask feature.  It also has an improved Auto Mask 
that handles image noise better. Any PV 3 image is 
automatically upgraded to PV 4 if it does not have an 
Auto Mask adjustment applied.

‣ Process Version 3 (2012) 
This is used for mages edited for the first time in Camera 
Raw 7.  It offers new tone controls and new tone-
mapping algorithms for high-contrast images. This 
introduced Highlights, Shadows, Whites, Blacks, 
Exposure, and Contrast in the Basic panel. You can also 
apply local corrections for white balance (Temp and 
Tint), Highlights, Shadows, Noise, and Moiré with the 
Adjustment Brush.

‣ Process Version 2 (2010) 
Images edited in Camera Raw 6 used PV 2 by default. PV 
2 offers improved sharpening and noise-reduction from 
the previous process version, PV 1.

‣ Process Version 1 (2003) 
The original processing engine used by Camera Raw 
versions 5.x and earlier.
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Go For the Latest Model
A legacy raw file will be much improved 
by using the latest Process Version, 
most notably reduced noise inherent in 
some early digital cameras.



PRESETS
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If you like a setting you’ve created, you 
can save it as a preset, which makes it 
easier to reload in the future. 
Remember that custom presets can 
serve as a great starting point 
(especially if you have several images 
from the same shoot). 

To make a preset, just click the pad-
shaped button at the bottom of the 
window. 

Beyond Presets
Be sure to explore the options  of 
custom profiles. They are much more 
powerful than presets and support 
auto-toning, LUTs, and more. Be sure to 
download and read the Profiles SDK.
https://helpx.adobe.com/photoshop/
digital-negative.html

figure:%23
figure:%23
figure:%23
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Another way to store a version of your 
image is to create a snapshot. Each 
snapshot is essentially a recording of 
the image’s current state. 

You can in fact create multiple 
snapshots for a raw file and easily 
switch between them.  The Snapshots 
are stored when you click the Done 
button or Open.



ADVANCED
CONTROLS

Now that you’ve mastered the essential 
sliders, it’s time to explore the deceptively 
powerful tools and commands.  These often 
go overlooked by most users.  Sure most will 
stumble upon the Crop or Straighten tools, but 
there are many hidden shortcuts and power 
techniques that really save you time.
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If you want to ensure an increase in 
crisp detail and improved color 
rendering, try the Enhance Details 
command.  This option is powered by 
Adobe Sensei and can produce more 
accurate renditions of edges, and fewer 
artifacts.

This option is most useful when you 
intend to make a large print (where 
fine details are more visible.). It works 
for raw images captured with a Bayer 
sensor  (Canon, Nikon, Sony, and 
others) and Fujifilm X-Trans sensors.



ENHANCE  DETAILS
To get started, open one or more supported raw files 
open in Adobe Camera Raw.

1. Ctrl-click (on Mac)/right-click (on Windows) the im-
age.

2. Click the menu at the top of the filmstrip and 
choose Enhance Details.

The Enhance Details Preview dialog box previews 
the effect. The hand cursor can be dragged to 
change the preview area. Click and hold to see a be-
fore view of the enhance effect.

You can also hold down and move the hand cursor 
to preview the before and after effect on different 
regions of the image.

3. Click the Enhance button to create an enhanced 
DNG version of your photo. 
 
The new DNG file is automatically stored next to the 
original source image on your hard drive.
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SUPPORTED FORMATS
Enhance Details is only applicable to Bayer and  X-Trans 
mosaic raw files.

UNSUPPORTED FORMATS
Enhance Details does not apply to the following types 
of source images:
‣ Non-raw files such as a JPEGs, TIFFs, and HEICs
‣ Linear DNGs (including HDR and pano DNG images 

created inside Lightroom and Camera Raw)
‣ DNG proxies and Smart Previews
‣ Monochrome raw files (such as Leica M 

MONOCHROM)
‣ Four-color cameras
‣ Foveon sensor images
‣ Fujifilm cameras with SR, EXR, or 2x4 mosaic 

sensors.
‣ Canon S-RAW/M-RAW files
‣ Nikon small raw files
‣ Pentax Pixel Shift Resolution (PSR) files
‣ Sony ARQ files
‣ Video files
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CROP & 
STRAIGHTEN
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Cropping is all about precision.  Often, 
you’ll want to crop to a specific aspect 
ratio. Sometimes its for the screen 
(video projects and slideshows) as well 
as print output. This is because you 
often need the shape of a photo to 
precisely match a target.



CROPPING
Cropping is very easy to achieve, but often involves an 
artistic decision.

1. Select an image for cropping.

2. Press the C key to invoke the Crop tool.

3. Click and hold on the Crop tool icon in the toolbar 
to see a drop down menu for aspect ratios. The ratios 
can be easily reversed then using the tool to switch 
between vertical and horizontal.

• Normal: An unconstrained cropping tool..
• 1 to 1:: This is a square-shaped crop.
• 2 to 3: A common ratio widely used for prints.
• 3 to 4: A ratio used by many older screens
• 4 to 5: This is a popular print size.
• 5 to 7: A crop used for prints and frames.
• 9 to 16: The aspect ratio for most modern screens.
• Custom: Enter your own ratio
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4. Drag a crop handle to crop the image. You can drag 
with a horizontal or vertical emphasis to change the 
ratio of cropping.

5. You can also click and drag to select the Crop Frame 
to freely position the crop.

6. You can modify the crop behavior if needed with a 
keyboard shortcut. Press the X key to toggle the 
orientation of the crop between portrait and 
landscape.

7. Press Return (or Enter) to apply the crop.  
You can exit without cropping by pressing the 
Escape key.

 
Remember, all cropping is nondestructive. You can always 
revert a cropped image by choosing Set to Original Crop 
from the pop-up menu to restore an image to its original 
crop.
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STRAIGHTENING
A crooked photo can be downright distracting (unless 
you really wanted it that way, of course). Fortunately, 
Adobe Camera Raw makes it easy to fix an unbalanced 
ball head. But what happens if you need to rotate the im-
age or even flip it? Not a problem these are all easy fixes.

There are three ways to easily straighten a photo in 
Adobe Camera Raw..

‣ Move the pointer to just outside a corner crop handle 
when using the Crop tool. The cursor will switch to 
Rotate. You can now drag to freely rotate the image 
(up to 45˚ either way).

‣ Choose the Straighten Tool and drag to draw along a 
horizontal or vertical line.

‣ Double-click the Straighten Tool to automatically 
straighten the image.
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ROTATE OR FLIP A PHOTO
While your camera can usually flag images properly for 
portrait and landscape, sometimes the motion position 
sensor in your  in your camera fails. Other times you 
might be shooting into a mirror or reflection and want to 
flip the image.

‣ To rotate the image 90˚ Click the Rotate Clockwise 
(R) or Rotate Counterclockwise (L) button in the 
toolbar.

‣ To flip the photo horizontally or vertically, hold down 
the Option (Alt) key.  The Rotate buttons become Flip 
image horizontally and Flip image vertically. This 
will make a mirror image of the photo.
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FIX 
PERSPECTIVE
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There are many factors that can 
introduce unwanted distortion into a 
photograph.  The two most common 
are using an incorrect lens and 
shooting from an extreme angle.  The 
perspective may become distorted.  
This is easiest to spot in photographs 
containing continuous vertical lines or 
geometric shapes.

Lens Correction First:
Always apply a lens correction profiles 
for your camera and lens combination 
first.  These fix several issues and pre-
pare the image to be analyzed better 
for distortion correction.



Adobe Camera Raw offers the Transform Tool to fix 

these problems. With four automatic Upright modes ─ 

Auto, Level, Vertical, Level, Full ─ and a Guided mode, 
it’s easy to fix perspective issues.

Let’s try fixing a perspective issue with the Upright 
adjustment.

1. Open a raw file into Adobe Camera Raw.

2. Navigate to the Lens Corrections panel. In the 
Profile tab, select the Enable Lens Profile 
Corrections check box.

3. Click the Transform Tool in the top toolbar. 
A new panel opens. 

4. In the Transform panel are four automatic Upright 
modes. Click a mode to apply the correction to the 
photo.

• Auto Applies a balanced set of perspective 
corrections.

• Level Applies perspective correction to ensure 
that the image is level.

• Vertical Applies level and vertical perspective 
corrections.

• Full Applies level, vertical, and horizontal 
perspective corrections.
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5. Cycle through the modes until you find a settings 
you like.

6. The last mode is Guided.  It allows you to draw two 
or more guides on a photo to customize 
perspective correction.

7. Draw the guides directly on your photo to indicate 
horizontal or vertical lines.. 
Once you have drawn at least two guides, the 
photo transforms interactively. You can use up to 4 
guides for an image.

8. In addition to auto correction options, you can also 
manually adjust the perspective of a photo. Use the 
sliders to fine-tune the perspective corrections.

• Vertical:Tilts the image forward or back in three-
dimensional space.

• Horizontal. Tilts the image side to side in three-
dimensional space. space.

• Rotate: Rotate  freely +/- 10˚.
• Aspect: Stretch the image horizontally or 

vertically.
• Scale: Enlarge the image overall to avoid 

transparent pixels.
• X Offset: Shift the image up or down.
• Y Offset: Shift the image left or right.. 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Experiment Freely:
All the five Upright modes are useful 
under different circumstances.  The 
right method varies image to image 
and can be affected by your personal 
taste.  Experiment with all five Upright 
modes before choosing one.
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The Spot Removal tool lets you repair 
a selected area by sampling pixels 
from a different area of the same 
image. The tool is quite useful in that 
keeps the data as a raw image, 
allowing the flexibility of further 
adjustments.

The tool is helpful for removing dust or 
unwanted details.  It is not as robust as 
the Healing Brush or Content-Aware 
Fill commands in Photoshop, but it’s 
still an important tool. It continues to 
process the raw image data directly. 
Also, since any edits and modifications 
to camera raw images are stored in 
sidecar files, this process is 
nondestructive.



1. Open a camera raw file.

2. Select the Spot Removal tool from the toolbar.

3. From the Type menu choose a method.

• Heal: Matches the texture, lighting, and shading 
of the sampled area to the selected area.

• Clone: Applies the sampled area of the image to 
the selected area.

4. Use the Size slider to specify the size of the area the 
Spot Removal tool affects.

• Left bracket ([) reduces the tool radius size.
• Right bracket (]) increases the tool radius size.

5. Click and draw on the part of the photo you want to 
retouch.

• A red-and-white marquee area (red handle) desig-
nates your selection.

• A green-and-white marquee area (green handle) 
designates the sampled area.
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6. If desired, change the sampled area to affect the 
blended results.

• Automatically: Click the handle of a selected 
area, and press the forward slash key (/). A new 
area is sampled. Press the forward slash key until 
you find a sample area that fits best.

• Manually: Use the green handle to reposition the 
sampled area.

Visualize Spots:
Are you having a hard time seeing all 
the dust or spots?  Be sure to try out 
the Visualize Spots option.  This fea-
ture helps you search for imperfections 
that may not be immediately visible. 
Just check the Visualize Spots check-
box (found in the options for the Spot 
Removal tool).  The inverted image 
makes it easier to see spots.  Be sure to 
adjust the threshold as needed. 
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SHORTCUTS & MODIFIERS
CIRCULAR SPOT:

‣ Control/Command + click to create a circular spot; 
drag to set the source of the spot.

‣ Command/Control + Option/Alt + click to create a cir-
cular spot; drag to set the size of the spot.

RECTANGULAR SELECTION:

‣ Click Option/Alt + drag to define a rectangular selec-
tion. All spots within that selection (highlighted in red) 
are deleted once the mouse is released.

EXTEND A SELECTED AREA OR SPOT:

‣ Shift + click to extend an existing selected spot in "con-
nect the dots" fashion.

DELETE A SELECTED AREA OR SPOT:

‣ Select a red or green handle, and press Delete to de-
lete a selected adjustment.

‣ Press Option/Alt and click a handle to delete it.

SPOT VISUALIZATION
When the Spot Visualization checkbox is selected, to 
change the visualization threshold:

‣ Increase:: Press period (.)

‣ Increase (in larger steps): Press Shift+period (.)

‣ Reduce: Press comma (,)

‣ Reduce (in larger steps): Press Shift+comma (,)
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In general, the sliders in Adobe 
Camera Raw target the entire image 
(or at least a range within the while 
photo).  But there are a collection if 
useful tools for creating a more 
targeted adjustment to a specific area 
of a photo.  

You can use the Adjustment Brush 
tool , the Graduated Filter tool , or 
the Radial Filter tool in Camera Raw. 
These offer far more localized 
adjustments.



MAKING LOCAL 
ADJUSTMENTS
Getting local adjustments “right”  will take some 
experimentation.  You should choose a tool and specify 
its options before you paint or draw.  You then paint or 
drag to add an adjustment to the image. Then you can 
go back and edit that adjustment, or apply a new one. 
All adjustments are added nondestructively to the 
image.

CHOOSING THE  
RIGHT TOOL
There are three local adjustment tools to select from.  
You can use one, two or all three in an image.  
Additionally you can use multiple instances of a tool 
depending upon the complexity of the photo.

‣ With the Adjustment Brush tool, you can 
selectively apply Exposure, Brightness, Clarity, and 
other adjustments by “painting” them onto the 
photo.

‣ With the Graduated Filter tool, you can apply the 
same types of adjustments gradually across a region 
of a photo with a gradient. You can make the region 
as wide or as narrow as you like to control the 
transition of the effect.

‣ With the Radial Filter tool, you can draw an 
elliptical area around the subject.  You can set the 
ellipse to apply adjustments to either outside or 
inside the selected area.
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MAKING A LOCAL 
ADJUSTMENT 
1. Select the Adjustment Brush tool from the toolbar.

2. Explore the options in the side panel.

3. Choose the type of adjustment you want to make 
by dragging an effects slider.
‣ Temp: Adjusts the color temperature of an area of 

the image, making it warmer or cooler.

‣ Tint: Compensates for a green or magenta cast.   

‣ Exposure: Sets the overall image brightness. 
Applying an Exposure local correction can achieve 
results similar to traditional dodging and burning. 
When combined with a graduated filter, it also 
makes a nice refinement for skies or shadows.

‣ Highlights: Recovers detail in overexposed 
highlight areas of an image.   

‣ Shadows: Recovers detail in underexposed 
shadow areas of an image. 

‣ Whites: Adjusts the white points in a photo 

‣ Blacks: Adjusts the black points in a photo 
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‣ Brightness: Adjusts the image brightness, with a 
greater effect in the midtones. 

‣ Contrast: With the Adjustment Brush or Radial/
Graduated Filter tools, you can selectively apply 
Exposure, Brightness, Clarity, and other adjustments 
by “painting” them onto the photo.

‣ Saturation: Changes the vividness or purity of the 
color. 

‣ Clarity: Adds depth to an image by increasing local 
contrast. 

‣ Dehaze: Reduces or increases existing haze. 

‣ Sharpness: Increases edge details.   

‣ Noise Reduction: Reduces luminance noise, which 
can become apparent when shadow areas are 
opened. 

‣ Moiré Reduction: Removes artifacts or color 
aliasing. 

‣ Defringe: Removes unwanted color fringing..

‣ Color: Applies a tint to the selected area. Select the 
hue by clicking the color sample box. 

4. Specify brush options as desired.
‣ Size: Specifies the diameter of the brush tip.
‣ Feather: Controls the softness of the brush stroke. 
‣ Flow: How quickly the adjustment is applied with 

each stroke.
‣ Density: Controls the amount of transparency in 

the stroke. 
‣ Auto Mask: Confines brush strokes based on edge 

detection. 
‣ Show Mask: Toggles visibility of the mask overlay 

in the image preview. 
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5. Paint with the Adjustment Brush tool.
• The cross hair indicates the application point. 
• The solid circle indicates the brush size. 
• The black-and-white dashed circle indicates the 

feather amount.
• Use the Auto Mask option to detect edges and 

further limit strokes.

6. When you release the mouse, a pin icon is added to 
indicate the application point. In the Adjustment 
Brush tool options, the mask mode changes to Add.

7. You can refine the effects of the area created by the 
brush after it is added by using the effect sliders
• Press the V key to hide or show the pin icons.
• To toggle visibility of the mask overlay, press the Y 

key, or position the mouse pointer over the pin.
• To undo part of the adjustment, click Erase in 

the Adjustment Brush tool options and paint over 
the adjustment’s mask to remove from the 
strokes.

• Remove the adjustment completely by choosing 
the pin and pressing the Delete key.

• Press Cmd+Z (Ctrl+Z) to undo your last 
adjustment.

• Click Clear All at the bottom of the tool options to 
remove all Adjustment Brush tool adjustments 
and set the mask mode to New.
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Multiple Strokes:
When working with multiple Adjust-
ment Brush adjustments, make sure 
you’re in Add mode to switch between 
them. Click a pin icon to select that ad-
justment and refine it.



THE GRADUATED  
FILTER TOOL
1. Open a photo in Adobe Camera Raw.

2. Select the Graduated Filter tool from the toolbar 
(or press G). 
Camera Raw opens the Graduated Filter tool 
options under the Histogram and sets the mask 
mode to New.

3. Choose the type of adjustments you want to make 
in the Graduated Filter tool options by using the 
related sliders.

4. Click and drag in the photo to apply a graduated 
filter across a region of the photo. 
A common application is to drag from top to 
bottom to adjust the sky.

5. Refine the filter by doing any of the following:
‣ Drag any of the effect sliders in the Graduated Filter 

tool options to customize it.
‣ Toggle visibility of the guide overlays by selecting 

the Overlay option (or press V).
‣ Drag the green or red dot to freely position or rotate 

the effect. Hold the Shift key to constrain the effect.
‣ Drag the black-and-white dotted line to shift the 

effect as a whole.
‣ Position the pointer over the green-and-white or 

red-and-white dotted line, near the green or red 
dot, until a double-pointing arrow appears. Then, 
drag to expand or contract the effect at that end of 
the selected range.
‣ Remove the filter by pressing Delete.
‣ Press Cmd+Z (Ctrl+Z) to undo your last adjustment.
‣ Click Clear All at the bottom of the tool options to 

remove all Graduated Filter tool effects and set the 
mask mode to New.

6. Use the Effect sliders to taste.  They are identical to 
the Adjustment Brush options covered earlier in the 
chapter.
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THE RADIAL FILTER TOOL
A useful way to control where a viewer's attention is 
drawn to within a photo is to add a vignette effect.  With 
the Radial Filer tool, these can be custom drawn and do 
not need to be centered.  Additional effects can also be 
added for a refined look

1. Open a photo in Adobe Camera Raw.

2. Select the Radial Filter tool from the toolbar (or 
press J). 
Camera Raw opens the Radial Filter tool options 
under the Histogram and sets the mask mode to 
New.

3. Choose the type of adjustments you want to make 
in the Radial Filter tool options by using the related 
sliders.

4. Click and drag in the photo to apply a graduated 
filter across a region of the photo and draw a 
circular or elliptical shape. This shape determines 
the area affected by or excluded from the 
adjustments.

5. Choose what area of the photo is modified with an 
Effect option (located below the sliders).

‣ Outside: All modifications are applied outside the 
selected area.
‣ Inside: All modifications are applied to the selected 

area.
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6. Adjust the size (width and height) and orientation of 
the Radial filter added. Click and drag the center of 
the filter to move and reposition it.
• Hover the pointer over any of the four filter 

handles, then click and drag to change the size of 
the filter.

• Hover the pointer close to the edge of the filter, 
the cursor changes to a curved two-headed 
arrow. Then click and drag to rotate the the filter 
boundaries.then click and drag the edge of the 
filter to change its orientation.

• Remove the filter by pressing Delete.
• Press Cmd+Z (Ctrl+Z) to undo your last 

adjustment.
• Click Clear All at the bottom of the tool options to 

remove all Graduated Filter tool effects and set 
the mask mode to New.

7. Use the Effect sliders to taste.  They are identical to 
the Adjustment Brush options covered earlier in the 
chapter.
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REFINE ADJUSTMENTS 
WITH MASKS
Adobe Camera Raw can restrict any of the local 
adjustments by using a Color, Luminance, or Depth 
Range Mask.  Each allows you to further refine the 
application of an effect based on an image property. 

DEPTH RANGE MASK
A depth range mask is only available only for photos 
that have embedded depth map information.  This 
includes photos such as those captured in the HEIC 
format on an Apple iPhone using Portrait mode.  In 
order to view this information, you’ll need to open the 
HEIC file directly using Adobe Camera Raw.

1. Launch Adobe Bridge by choosing File > Browse in 
Bridge from Adobe Photoshop.

2. Navigate to the desired HEIC file and then right-
click on it.

3. Choose Open in Camera Raw.

4. In the toolbar of the Camera Raw dialog box, select 
the Adjustment Brush tool, Graduated Filter tool, or 
Radial Filter tool. 

5. Create an initial selection mask over a specific area 
of your photo that you want to correct.
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6.  From the tool options in the Adjustment panel on 
the right, choose the Range Mask type as Depth 
from the drop-down list.

7. Select the Visualize Depth Map check box to view 
the depth information of the photo in black and 
white representation. This makes it easier to 
determine which areas are affected and which are 
ignored.

8. Select a depth range within the mask area:

9. Adjust the Depth Range slider to set the endpoints 
of the selected depth range.

10. Use the Smoothness slider to adjust the 
smoothness of the falloff at either end of the 
selected depth range.

11. Deselect the Visualize Depth Map check box and 
refine the adjustment to taste.
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COLOR RANGE MASK
After making an initial selection mask in a photo, you 
can further target its results with a selection mask based 
on the colors that you sample within the mask area.

1. Open a photo in Adobe Camera Raw.

2. Use the Radial Filter tool, Graduated Filter tool, 
or Adjustment Brush tool to create an initial 
selection.

3. From the tool options in the Adjustment panel on 
the right, choose the Range Mask type as Color 
from the drop-down list. 

4. Use the eyedropper (near the Range Mask option) 
to sample a color within the mask area to limit the 
effect. Do any of the following:
‣ To sample a single color within the mask area, click 

the eyedropper at the desired location. 
‣ For more accurate color selection, click+drag an 

area around the colors that you want to adjust.
‣ To sample colors from multiple selections, hold the 

Shift key while selecting a single color (Shift+click) 
or while selecting an area (Shift+click+drag). You 
can add up to five color samples.
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5. Adjust the Color Range slider to narrow or broaden 
the range of selected colors.

6. To exit color sampling, press the Esc key or click the 
eyedropper (near the Range Mask option).

7. Use the sliders for the effect to make targeted 
adjustments based on the selected color or color 
ranges. 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LUMINANCE RANGE MASK
After making an initial selection mask in a photo, you 
can further target its results with a selection mask based 
on a brightness range that you sample within the mask 
area.

1. Open a photo in Adobe Camera Raw.

2.  Use the Radial Filter tool, Graduated Filter tool, 
or Adjustment Brush tool to create an initial 
selection.

3. From the tool options in the Adjustment panel on 
the right, choose the Range Mask type as 
Luminance from the drop-down list. 

4. Use the sliders or eyedropper (near the Range Mask 
option) to choose a luminance range within the 
mask area to limit the effect. Do any of the 
following:
‣ Drag the sliders to set a range based on light and 

dark areas.
‣ Click+drag an area around the range in the photo 

that you want to adjust.
‣ Use the Smoothness slider to adjust how smooth 

the falloff is at either end of the luminance range.

5. Select the Visualize Luminance Map check box to 
view the luminance information of the photo in 
black and white representation.  
The part in red color shows the actual area masked.

6. Refine the mask as needed with the sliders, then 
uncheck the Visualize Luminance Map check box.

7. Use the sliders for the effect to make targeted 
adjustments based on the selected luminance 
range. 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SHORTCUTS & 
MODIFIERS
NEW RADIAL FILTER ADJUSTMENTS:

‣ Press and hold Shift while dragging to create an ad-
justment that is constrained to a circle.

‣ While dragging, press and hold the spacebar to 
move the ellipse; release the spacebar to resume de-
fining the shape of the new adjustment.

EDITING ADJUSTMENTS:

‣ While dragging inside an adjustment to move it, 
press and hold Shift to constrain the movement in 
the horizontal or vertical direction.

‣ While dragging one of the four handles to resize an 
adjustment, press and hold Shift to preserve the as-
pect ratio of the adjustment shape.

‣ While dragging the boundary of an adjustment to 
rotate it, press and hold Shift to snap the rotation to 
15-degree increments.

‣ While an adjustment is selected, press X to flip the 
effect direction (for example, from outside to in-
side).

DELETING ADJUSTMENTS:

‣ While an adjustment pin is selected, press Delete to 
delete the adjustment.

‣ Press Option/Alt + click an existing adjustment to 
delete it.

‣ Adjustments with maximum coverage

‣ Press Command/Control and double-click an 
empty area to create an adjustment that is centered 
and covers the cropped image area.

‣  Press Command/Control and double-click within 
an existing adjustment to expand that adjustment to 
cover the cropped image area.
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KEYBOARD 
SHORTCUTS
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Result Windows macOS

Zoom in Control + (+) Command + (+)

Zoom out Control + (-) Command + (-)

Zoom to 100% Control + Alt + 0 Command + Option + 0

Zoom to fit Control + 0 Command + 0

Step back through Edit history Control + Z Command + Z

Undo Control + Alt + Z Command + Option + Z

Redo Control + Shift Command + Shift

Preferences Control + K Command + K



Result Windows macOS

Select all images Control + A Command + A

Select all rated images Control + Alt + A Command + Alt + A

Select only main image Control + D Command + D

Synchronize selected images Alt + S Option + S

Synchronize selected images with no 
dialog

Alt + Shift + S Option + Shift + S

Merge selected images to a panorama Control + M Command + M

Merge selected images to HDR Alt + M Option + M

Merge selected images to a panorama 
(no dialog)

Control + Shift + M Command + Shift + M

Merge selected images to HDR (no 
dialog)

Alt + Shift + M Opt + Shift + M

Rotate image right (clockwise) Control + ] Command + ]

Rotate image left (counterclockwise) Control + [ Command + [

Mark image as rejected Alt + Backspace Option + Delete



Result Windows macOS

Open image Control + O Command + O

Open image copy Control + Alt + O Command + Option + O

Open as smart object Control + Shift + O Command + Shift + O

Save image Control + S Command + S

Save image without dialog Control + Alt + S Command + Alt + S

Apply auto adjustments Control + U Command + U

Apply default adjustments Control + R Command + R

Decrease current brush size [ [

Increase current brush size ] ]

Toggle brush overlay V V



HDR 
SHORTCUTS

Adobe Camera Raw is a very versatile application.  
Besides the ability to develop photos it can also 
create new types of images like panoramic and 
HDR images made from multiple source images.  It 
can also convert file types and backup your work to 
a new file.
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© Luke Stackpoole 

More than Raw Files
You can in fact open TIFF and JPEG 
files using the Camera Raw plug-in. 
You need to switch to Adobe Bridge 
and select the desired files. Then 
choose File > Open In Camera Raw. 
You won’t see any major benefits to 
image quality, but you can use the 
Camera Raw dialog box to adjust the 
images. 



PANORAMIC 
IMAGES
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With Adobe Camera Raw, you can 
merge multiple raw files from a  
panoramic sequence into a new DNG 
image.  This new panorama composite 
preserves all of the flexibility of a raw 
file which leads to a huge boost in 
editing flexibility. This feature works 
with both traditional panoramic as well 
as multi-bracketed HDR panoramic 
photos.  

Better Stitching
For the best results when merging 
panoramic images have at least a 25% 
overlap between shots.  Shooting a 
vertical image also leads to less 
distortion.

© Isis França



1. .Choose File > Open and select multiple raw or 
DNG source images.

2. In the Camera Raw dialog box, select the images 
that you want to merge in the Filmstrip panel.   
To select all images press Command+A (Ctrl+A) or 
use the Shift key to select a range if images.

3. Right-click on an image in the panel and choose 
one of the following:
‣ For standard exposure photos, select Merge to 

Panorama.
‣ For exposure bracketed photos, select Merge to 

HDR Panorama to merge them into an HDR 
panorama.

4. In the Panorama Merge Preview / HDR Panorama 
Merge Preview dialog box, you can set layout 
options. Choose a layout projection method based 
on the photos:
‣ Spherical: Aligns and transforms the images as if 

they are mapped to the inside of a sphere. This 
projection mode is great for very wide or multi-row 
panoramas. It also works well for aerial 360˚ images 
made with a drone.
‣ Cylindrical: Projects the panorama as if it is 

mapped to the inside of a cylinder. This projection 
mode works really well for wide panoramas.  It also 
keeps vertical lines straight from some architectural 
images.
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‣ Perspective: Projects the panorama as if it is 
mapped to a flat surface. Since this mode keeps 
straight lines straight, it is great for architectural 
photography. Very wide panoramas may not work 
well with this mode due to excessive distortion near 
the edges of the resulting panorama. This method 
usually needs a strong central image and works 
best with an odd number of source images.

5. Adjust  the Boundary Warp slider setting (0-100) 
to warp panoramas/HDR panoramas to fill the 
canvas. This is useful to remove transparent areas 
and minimize cropping. A higher slider value causes 
the boundary of the panorama to stretch to the 
surrounding rectangular frame.

6. Select the Auto Crop setting to remove undesired 
areas of transparency around the merged image.

7. When you are happy with the preview image, click 
Merge in the preview dialog box.

‣ In the Merge Result dialog box, you can enter a 
location and name and click Save. 

‣ Alt-click Merge to save the panorama in the same 
folder as the source image with a default file name.

8. The new file may take some time to merge.  You 
can track its progress in the lower left corner.

9. Develop the new raw file like you would any other 
raw image.
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PANORAMIC
SHORTCUTS
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Result Windows macOS

Spherical panorama projection Control + 1 Command + 1

Cylindrical panorama projection Control + 2 Command + 2

Perspective panorama projection Control + 3 Command + 3

Auto crop panorama C C



HDR 
IMAGES
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With Adobe Camera Raw, you can 
merge multiple raw files from a  series 
of exposure bracketed images.  
Typically, these shots are captured 
using Auto Exposure Bracketing on a 
camera to ensure a wider dynamic 
range.  These newly merged DNG files 
contain more exposure information 
than a single raw file.

Better HDR Merging
For the best results when merging 
HDR images, shoot from a tripod or 
brace the camera.  You want to 
minimize camera movement to 
prevent soft focus or shake on the 
longer exposures.

© Neil Thomas



1. Choose File > Open and select multiple raw or DNG 
source images.

2. In the Camera Raw dialog box, select the images 
that you want to merge in the Filmstrip panel.  To 
select all images press Command+A (Ctrl+A) or use 
the Shift key to select a raw images.

3. Right-click on an image in the panel and choose 
Merge to HDR.

4. In the HDR Merge Preview dialog, consider these 
two options.

‣ Auto Tone:: Provides a good starting point for an 
evenly-toned merged image

‣ Auto Align: Useful if the images being merged 
have slight movement from shot to shot. Enable 
this option if the images were shot using a handheld 
camera. Enabling this option may not be necessary 
if the images were shot using a tripod.
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5. If there was a lot of movement within a shot or a 
long time between exposures, you may see 
unnaturally semi-transparent areas. Select one of 
the following deghosting option in the HDR Merge 
Preview dialog box to correct these anomalies: 
None, Low, Medium, or High. Try Low deghosting 
first to obtain a clean merged image. Go higher if 
necessary.

6. Click Merge to create the HDR image (.dng).

‣ In the Merge Result dialog box, you can enter a 
location and name and click Save. 
‣ Option-click (Alt-click)Merge to save the panorama 

in the same folder as the source image with the 
default file name.

7. Develop the new raw file like you would any other 
raw image.
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SHORTCUTS

Result Windows macOS

Align source images A A

Visualize deghosting Y Y

Auto tone HDR result T T



WORKFLOW 
OPTIONS
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Near the bottom of the Camera Raw 
window is an unobtrusive line of text.  
On first glance it appears to list the 
specs for the file that will be created. If 
you look closely, you’ll notice that this 
text is underlined like a hyperlink. 
Clicking it opens a world of options 
and some truly useful commands.

This easy to miss control is called 
Workflow options.  It’s how you can 
specify settings for all files output 
from Camera Raw, including the color 
bit depth, color space, output 
sharpening, and pixel dimensions. 
These are the instructions on how 
Photoshop will open these files.

© Isis França



SPACE

This controls which color space is used 
when you open the file. The standard is 
the Adobe RGB working space. But you 
can choose any color space that you have 
loaded to adjust for printing output or 
other workflows.

The profiles listed in the Space menu are 
built in to Camera Raw. To use a color 
space that’s not listed, choose the 
ProPhoto RGB space. A file opened in this 
color space can easily be converted to 
what ever space a printer/paper 
combination requires.

DEPTH

Specifies whether the file opens as an 
8‐bpc or 16‐bpc image in Photoshop. The 
16 bits per channel option is ideal for the 
maximum image quality and accuracy of 
color and tone.
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SIZE

Specifies the pixel dimensions of the image when 
imported into Photoshop. You can choose from a 
variety of options for measurement as well as enlarging 
or reducing the photo when you open it.

‣ The default pixel dimensions are those used to 
photograph the image. 

‣ Check the Resize to Fit box and choose a size from 
the menu.

• Enter a specific width and height

• Enter a not to exceed size

• Choose a megapixel count

• Scale based on a percentage of the original size

‣ Choosing a smaller-than-native size can speed 
processing when you are planning a smaller final 
image. 

‣ Picking a larger size is like upsampling in 
Photoshop. 

‣ You can always change the pixel size of the image 
after it opens up in Photoshop.

RESOLUTION

Resolution identifies the pixels per inch at which the 
image is printed. This has no effect on the total pixel 
count and only effects the print output.  An output of 
240 pixels or higher is often used for printing while 72 
to 120 pixels is used for screen application. You can also 
use the Image Size command to adjust resolution in 
Photoshop.

SHARPEN FOR

This useful option applies output sharpening for Screen, 
Matte Paper, or Glossy Paper.  You can choose between 
three strengths with the Amount pop-up menu.  In most 
cases, you can leave the Amount set to the default 
option, Standard.  This is a useful option to preserve 
edge detail.
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OPEN IN PHOTOSHOP AS SMART OBJECTS

When checked, this option opens the raw photo as a 
Smart Object layer instead of a background layer.  This is 
very useful for several reasons,

‣ A backup copy of the raw file is embedded into the 
Photoshop layer (it can be exported on its own if 
needed in the future).

‣ Double-clicking the Smart Object layer returns you 
to editing the embedded raw image with no loss of 
quality.

‣ The layer can be nondestructively scaled or 
transformed while retaining all of the original detail 
for future adjustments.

‣  Photoshop filters can be applied non-
destructively to the layer.

This option is HIGHLY desirable and should be checked 
for most workflows. To override this preference for 
selected images, hold the Shift down when clicking the 
Open button.
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SAVING 
FILES
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Once you’ve developed one or more 
images, it’s time to save.  You can choose 
to export directly from the Camera Raw 
dialog box as a PSD, TIFF, JPEG, or DNG 
format file..

When you click the Save Image command 
in the Camera Raw dialog box, files are 
placed in a queue for processing. This is 
useful if you are creating several files at 
once and saving them in the same format.

Syncing Feeling
Remember, you can synchronize multi-
ple files to use the same settings.  
Choose the reference image first and 
then select the rest.  With a right-click 
you can choose Sync Settings.  You can 
now Save multiple images too!

© Max Langelott



SAVE A RAW IMAGE IN 
ANOTHER FORMAT
1. In the Camera Raw dialog box, click the Save 

Image.. button in the lower-left corner of the dialog 
box. This opens up a new dialog to specify options. 
If you Option-click (Alt-click) the Save Image 
button, the last specified settings will be reused.

2. In the Save Options dialog box, specify the 
following options:

‣ Destination:  Specifies where to save the file. If 
needed, click the Select Folder button and navigate 
to the desired location.

‣ File Naming:  Specifies the filename using a 
naming convention that includes elements such as 
date, original name and camera serial number. 
Using descriptive filenames based on a naming 
convention helps you keep image files organized on 
your hard drive.

3. Choose a file format from the Format menu. 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‣ Digital Negative: This saves a copy of the raw file 
in the universal DNG file format. Use the 
Compatibility option to specify the versions of 
Camera Raw and Lightroom that can read the file.

• By default, the conversion uses lossless 
compression, which means no information is lost 
while reducing file size. 

• Choosing Linear (Demosaiced) option stores the 
image data in an interpolated format. This means 
other applications can read the file even if that 
software doesn’t have a profile for the digital 
camera that captured the image.   

• JPEG Preview: Embeds a JPEG preview in the 
DNG file. If you decide to embed a JPEG preview, 
you can choose the preview size. If you embed 
JPEG previews, other applications can view the 
contents of the DNG file without parsing the 
camera raw data.   

• Embed Original Raw File: Stores all the original 
camera raw image data in the DNG file.    
 

‣ JPEG: Saves copies of the camera raw files in JPEG 
(Joint Photographic Experts Group) format. 

• To specify the amount of compression, enter a 
value from 0 to 12.  Using. a higher value applies 
less compression and increases file size and 
image quality.

‣ TIFF: Saves copies of the camera raw files as TIFF 
(Tagged-ImageFile Format) files. 

• Specify whether to apply no compression, or 
LZW or ZIP file compression to reduce file size.

• TIFF is a flexible bitmap image format supported 
by nearly all paint, image-editing, and page-
layout applications. 

‣ Photoshop: Saves copies of the camera raw files in 
the PSD file format. You can specify whether to 
preserve cropped pixel data in the PSD file. 

4. When ready, click Save to create the file(s).. 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